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Overview

09:30 Tea / Coffee - Registration

10:00 Session 1

11:30 Tea/Coffee - Time to Connect
11:50 Session 2

13:30 Finish
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Ask your guestion




High-quality Music teaching...

Looking at Music
Draft Guide for Post-Primary Schools

...Integrates the three core disciplines of
listening, composing and performing.
These are not taught in isolation but are
meaningfully connected.

This integrated approach deepens
understanding and reinforces theoretical
knowledge through practical application.

Looking at Music Draft Guide for Post-Primary Schools (2025), p.7



Learning together, we will...

- consider the Why, What and How of vocal warmups for classroom singing
 share our experiences of nurturing and motivating our young singers

- discuss key considerations when selecting and preparing repertoire

demonstrate how DLT can support singing in the Music classroom

iInvestigate how to layer up the learning when teaching a song

experience some beatboxing and lilting

explore singing as a learning tool when teaching other areas of the curriculum

meet the final series of our trilogy - Meet the Voice

_




Vocal Warmups

The Why,
What and
How!

Dr Lynsey Callaghan
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Vocal Warmups

Consider the vocal warmups on p. 1
Share an exercise that you find

supports learning in the classroom

Activate Your Voice Booklet, pp.1-2



Motivating the Student

Share strategies for how
you nurture the shy and/or

unenthusiastic singer

Image generated using Google Gemini

Activate Your Voice Booklet, p.2



Strategies Shared

...Some students can be anxious singing in front of
...model positive others. Build resilience over time — start by getting them to
confident singing perform to one person they choose, then a small group of
friends, then others etc.

...make singing a part of the . . :
normal classroom routine ...pique their interest with a song
don’t make a big deal of izi they already know/are familiar with,

and then bring in the warm-ups

...change the environment e.q., go outside

...don’t be afraid to have fun
yourself. Positive for the students

...start by not singing, do exercises while to see that it is enjoyable
speaking, not singing!

_

...Incorporate physical games




Sharing Repertoire

Share a song that supported your
students in engaging with singing

and learning in the Music classroom

u - ®
]
Activate Your Voice Padlet



Repertoire Shared

Oide + 27 « March 2, 2026

Oide Music: Activate Your Voice - 28th February 2026

Kevin Barry Room, NCH. Spreaghadh

Solo Songs Solo Songs Solo Songs
Falling slowly I'm Yours Dreams Cranberries
Dancing Through Life Summerfly - Eleanor Solo song for low female

McEvoy voices - Feels like home -
@ Randy Newman

@
Linger Cranberries

Dynamite
@ @
The scientist @ To market ' Marion

= Ingolsby
(@

= Hallelujah (L. Cohen)
Midnight Sun - Zara @
Larsson @
Beauty and the Beast
& Lay Me Down - The Frames
[ — &
Love me tender @
Castle on a Cloud

& Canoe song - ‘my paddle’s

keen and bright’ - round and &

I Like The Flowers drone added; instruments
for those who won't sing Memories
@ (e.g. drone on chime bars) =

S

One horse - short canon

&

Group Songs

Die with a smile -burno
mars , lady gaga

@

Count on Me - Bruno Mars

My Bonnie Lies Over the
Ocean

@

Old Town - Phil Lynott

@

Killeagh by Kingfisher
@

Bruno mars - Count on me
(key of C, ties in with theory
well too)

@

Steve’s Lava Chicken

@

‘ Oide

G~ /A

Group Songs i Group Songs Group Songs
Killeagh . Dynamite Part of your World
S @ & S

True Colours Mango kiwi warm up Black Velvet Band
(&4 (&

Viva la vida for
boomwhackers and cajons
and vocals

Super trooper Jersey Giant

&) Rule the world Girls just wanna have fun -
The Mayries

Dreams The Cranberries
(@)1

TATE W
Native American Chants \

Rockabye - the Mayries

Practice dynamics and
timbre

from Voiceworks 1. Easy
chordal harmonies in minor
tonality with Canon option
also

@ A Million Dreams 2-part

Dona Nobis pacem round &
@

S Feeling Good 2-part

High Hopes - The Mayries

Hi Ho lumineers @
3 . & Somewhere only we know
Hey Jude &)

@




Oide

Selecting Repertoire

What key factors do you consider
when selecting a song for your

students?

Activate Your Voice Booklet, p.3



DLT Supporting Your Selection

@ oid Documents > Music > Oide Music Digital Score Library
World in Union - Oide Music Digital Score
S e Library O Name - Modified ~
= = Zu Midi Files X May9,2024
A R A A A [0 PDF Files 3 January 28, 2025
s i \—r—r—l = Click to open 2
. XML Files b May 9, 2024
Vox | %: = —
" ‘ " [@i  How to Import or Export an XML or Ml... 32 November 15, 2024
NEE T ézﬁﬂri}*
( B r' o = —t " =
99 ; _ — " n
T * Download MusicXML file
<2 [I3E ===
- . h = _ ,:
h %ﬁ F u’ ‘ V = I ’ [} ]
==
| * Import into your notation software

« Adapt as desired

Activate Your Voice Booklet, p.7



How to...?

Oide DLT Music Supports

Using Digital Learning Technologies

T n famlirdia e -~ SRS

Using Digital Learning Technologies

The Practical: Fdit Scares for mv School Context continued

The Practical: Edit Scores for my School Context

Using Digital Learning Technologies

The Learning How to...
MusicXML See Companion Supports /
FiEs o Import MusicXML /// Flof
* Export MusicXML
CHANGE 1. Double-click on instrument name on score -
to open Staff/Part Properties - =
INSTRUMENTS 2. Click Replace instrument
3. Choose instrument and click OK
4. Click 0K =R
CHANGE THE 1. If there is no existing tempo marking, click on the first note or rest (If there is
TEMPO an existing tempo marking go to step 4) - -
2. If Palettes is not visible on the left click View-> Palettes iy
3. Click the Tempo arrow (> ) in Palettes i
4. Double-click the required tempo marking e
5. Double-click the tempo marking when it appears on the score and change
the number to the required value
TRANSPOSE TOA 1 Press escape keytodeselectall
SUITABLE K5V 2. Click Tools -> Transpose S
L ChckTokey @) comnt e/ -
4. Select new key Qw
5. Click OK A=

Cut - Copy - Paste

Delete

Remove
Instrument

o Select Multiple Bars

1

2.
3.

REARRANGE THE MUSIC TO SUIT YOUR STUDENTS

1. Click the first note of the selection
2. Hold down shift key
3. Click the last note of selection

Cut: Ctrl/Cmd+X Copy: Ctrl/Cmd+C Paste: Ctrl/CmdeV

* Backspace to delete notes
*  Ctrl/Cmd + Backspace to delete bars e

Click Instruments

(Click View-> Instruments if not visible)
Click required instrument

Click this symbol & to remove selected
Instruments or this symbol = to hide @ o vieonceo
selected instruments

@ . e

e 888

Eoidede

X @0ide_Music

®
nts
g

(i)
ss the Play

Mixer

% Flat

ide

Using Digital Learning Technologies

The D iral- Edit Senrac far mu Schanl Cantevt eantinued

W Flat

Using Digital Learning Technologies

Th janl. Cdis © £, Cobhnnl Fantaut

2 Flat

Using Digital Learning Technologies

Y
The Practical: Edit Scores for my School Context % Flat

The Learning How to...
MUSICXML See Companion Supports
FILES = mport MusciOR n ///// Flat
_Export MusicXML
CHANGE 1. Click on instrument name
2. In Instrument Settings, go to the Instrument you want to change
INSTRUMENTS 3 Click Replace
4. Choose your new instrument
5._Click Done
CHANGE THE TEMPO 1. Ifthere is no existing tempo marking, you can add a tempo mark by going
to the Measure/Bar toolbar and click on the tempo tool icon #%
2. To change the existing tempo, click the tempo mark
3. Type in the new tempo
4. If needed, click the beat unit to change the existing beat
5. Click Save
6. Please note: by pressing the audio icon, <) you can see all tempo
options
TRANSPOSE TO A . Select all - Shift + Ctri/Cmd + A

1
2. Select Note > Transpose icon '*!
SUTTABLE &Y 3. Choose whether to transpose by key, interval or semitone
4. Select new key

5.

. Click Apply Transposition

REARRANGE THE MUSIC TO SUIT YOUR STUDENTS
« Select Multiple Bars 1. To start a range selection, hold the mouse left button

2. Drag the mouse to the extend the selection or alternatively hold down shift
key and drag to the last note of the selection/ hold down shift key and use the
arrows
Use the anchors to extend or reduce the range selection &5

w

o Cut-Copy-Paste  Cut:Crl/Cmd+X ¥ Copy:Ctrl/Cmd+C [J Paste: Ctrl/Cmd+V (]

* Delete Backspace to clear notes or altematively Click the delete icon
Select /8:

Ctrl/Cmd + Backspace to remove measures
* Remove Instrument 1. Click on instrument name
2. Go to Instrument in Instrument Settings
3. Click Remove
4. Click Yes
5. Click Done

@uldt. ie

X @0ide_Music

(the cursor

he cursor

omise
Jstring

s you
icon [

wav)

Activate Your Voice Booklet, p.24



Preparing for Rehearsal

How do you introduce
a new song to your

students?

Activate Your Voice Booklet, p.3



Preparing for Rehearsal

Together with your group, consider...

1. overall shape
2. a possible starting point
3. potential technical challenges

4. 3-4 musical features

Piano

Don't Tell Me
Arr. Oide Musi

de Music Team
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Activate Your Voice Booklet, pp.8-10



A Possible Starting Point

Response 1
= SErEsEEs
o) .a' o ‘@‘,ooo
Don't tell me | can't be__who | am
Response 2
5 D ;
i S
Don't tell me | can't be_who | am

_



Teaching the Song — Tricky Rhythms

Call 1

¢ S5s-E=
SSSSsss=SSE Eese
Put mein a box__ and tick it Answer each
Call 2
%#3 S e = call with
> RGN Response 1
Make me a- fraid__  to feel it
Call 3
%I: — p————— o oy g -
e - ‘}O ¥ —& & .‘-_-—H et @ ‘;‘\_/‘

I'll put you in a spot_and then say it

_




Oide

Technical Point 1

8ve Leap
%ﬁ 3 - \ J; ¥y o & g =
Don't tell me | can't be__ w L
Preparatory Warmup
Dm Bb Am
 ——  S——  ——
Oohah ya__ Oohah ya__ Oohah ya__ Oohah ya__
5 Dm C Bb Am
[a)
—_éy;'-f d,‘,i *f d,,i *f i,,g *f d,,il
Q) .o > a g - o —T .

@

Oohah ya__ Oohah ya__ Oohah ya__ Oohah ia_ -



Technical Point 2

VoxT

Vox2

Pno.

Vox1

Vox?2

Pno.

‘ Oide

Modulation

E minor =) D minor
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bb.29-36




Preparatory Warmup

Em A Dm G

[ i
[
. D
.
& &9 / N L &
& & (L& (BT .

rY) o g ® 7 @ &

Moving from E minor — D minor

bb.29-36



Singing Across the Curriculum

1

What learning from other
areas of the curriculum

might this song support?

2
3
4

Activate Your Voice Booklet, p.8



Let's Sing!

Don't Tell Me

Arr. Oide Music Team
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Tum the key in the lock,__ donttell me___

e

hd 14
— Don't lell me lcan't bs__who |
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Score on pp.9-10

As we sing through this score,
consider for what cohort of

your students might this

arrangement suit?

Full Piano Vocal Score available to download from Oide website



Time to
connect

See you
at 11:45




NMeet the Tri

$ Go'to Oide.ie/Music to download ind

rs

Meet the Artist Meet the Instrument

s

.@
ﬁ . 3 Banjo - Dan Larkin Bédhran - Dermot Sheedy ‘ | Boutouki-Ddnal tunny
\ | A
1

Al Habon Tuor

Toshin Emmanuel Lawler Niamh Bury
Afro Pop, Rock, R'nB 113

Z .

Helen Kearns Aoife Doyle
Soprano

{ Hand Pan - Dale McKay | { Harmonica - Don Baker

Piano ~ Una Keane - Sarode - Matthew Noone |

- s < : ;
( H f § Muireann NicAmhlaoibh Simon Morgan
W ) Oide : §i'E Sean Nés Baritone Jazz Opera

[ Tin Whistle - Mary Bergin Trombone - James O'Leary | [ Uilteann Pipes - Mark Redmond |

All videos and accompanying resources available at www.olde.ie o Oide.ie/post-primary/home/music/ [QHOH| Oide.ie/post-primary/home/music/

o Tac( leis an bhFoghlaim Supporting the Professional
I e Ghairmidil i mease Ceannairi  Learning of School Leaders
Scoile agus Muinteoiri and Teachers
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Activate Your Beatbox

Bass drum

Snare drum Crash Cymbal

B T K Tsh

- oo



Four to the Floor

Bass drum Bass drum Bass drum Bass drum

B B B B

_



Backbeat

Bass drum Snare drum Bass drum Snare drum

B K B K

- oo



Add the Hi-hat

Snare drum

B T K T

- oo

Bass drum



Drum Roll

' Hi-hat Snare drum Snare drum ‘ Crash Cvmbal
rash Cymba

Repeat x 3

_



Combine Sounds

Bass drum and
Crash Cymbal

Bsh
_



Singing On and Off the Beat

%%: :|:-7 e ————
== == ==

[ 4 [ 4 [ 4 [ 4
Naa naa naa naa na na na




Performing the Melody & Accompaniment

%’éll’ J/ J\!‘, ‘ll - o E— S R — — I
v &
Naa na na Naa na na Naa na na na na na na

BT KTBTKT|BT KT




Harmony Singing in Octaves

Preparatory Warmup

[

N :
- I: o o e - 3|
=
Wantmoreand more just love what
[a)
K I‘ :I
ESSs = = = =
Wantmoreand more just love what

_



Harmony Singing in 6ths

Preparatory Warmup

S - o
s I: (3 © o I
L
Wantmoreand  more just love what
S==s=s , —
o ® o ¥ ° o * &
Wantmoreand more____ just love what___

Lower voice moves to the harmony note by step

_



Harmony Singing in 6ths

Preparatory Warmup

) K :
> e ? I: © O © ) :I
L
Wantmoreand more just love what
; | |
ﬁ F—itn — = =
Wantmoreand more just love what

_




Syncopation

Preparatory Warmup

%,ﬂ; — 5 ——

ba ba ba ba ba




Building the Score and Performance

Harmony in 6ths

’ ——0"—0.—® - — 5 5
: 00 4 e e d e g rraa
, — R R
ba ba ba ba ba ba baba ba ba ba baba ba ba ba baba ba ba
%yncopanon
— !_ju JP\’.’J e RN NN ) r:l
> _‘_._‘_ > > o ¥ J J J & ‘.—‘ & &
ba baba ba ba ba baba ba ba ba baba ba ba ba baba ba ba
I\ﬂelody Accompaniment
ﬁ:dj—‘i\,}—.‘%‘ﬂ—'f‘) T—F+r4 BTKTBTKT
o @ &' r 2 -J' _?_ _5?
Naa na na Naa na na Naa na na na na na na T i A Jg @

A A



Let's Sing!

@5 ‘ Oide g Hpi
Freed From Desire
Arr. Oide Music Team Molella. : (}?;rmeni

atto
Intro
m
0
Melody — p— —
Line —
ba b
fH
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I| ooh
H
vice 2 T  — =
K LA
ba a  ba
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| |
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e S
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My 1 mon

BB |p—d 2 | |

Score Bon pp.15-22

As we sing through this score,
consider what cohort of your

students this song might suit?

Activate Your Voice Booklet, p.3



Developing the Ear and the Eye - Sight Singing

(o))
(&)
Btwd
N
(o))
(&)
(8]
(&)
— O
(&)
g‘wd
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E1wd
S
(&)
(&)

q
q

= o ©
1 2
d r

o
3 4 5 1
d

~ N ¢
W
& G
w

=~ N QY
(&) ]

Movement: 1 = knees, 2 = thighs, 3 = hips, 4 = walist, 5 = shoulders, 6 = head
Develop the inner ear: sing along with the audio



https://www.yout-ube.com/watch?v=oto3qW9T8hw&list=RDoto3qW9T8hw&start_radio=1

The Conspiracy Reel

B q
- ¢
-4
-~ §

B q

=

= T < — 2 z < z
m f d

m f m

What other areas of the curriculum
might the learning here support?



Lilting Rhythm

L

Dum Da Dy Do Dee Dy Dum
I Y
Da Dy Da Do Dee Dy Day

- oo



Layering the Rhythm

S I A

Dum Da Dydin  Dodin Dee Dy Dum

S I 0 e S

Da Dy Dadin Dodin Deedin  Dydin Day

- oo



Lilting with an Upbeat

Rl s s Y A |

Dee - um Da Dydin  Dodin Dee Dy Dum
Dee - a Dy Dadin Dodin  Deedin  Dydin Day

- oo



Progressing the Learning

Sl IV - YR I R P A

Dee - um Diddly Eydin Dodin Deedin Diddly Dum

Bl - Y R 0 R - R

Dee - adin Diddly Adin Dodin Diddly Eydin Day

_




Lilting Melody

~2
[
P~
e
(==

4 o o 4 4 & >
dum da dy do dee dy dum da dy da do dee dy day

=4 J g & 4 & 4

¢
L Y
Y

- oo



Lilting — Building the Melody

el =

¢4 o o 49 > ¢4 o ¢ 904
Dee - um da dy-dindo-din dee dy dum da dy da-dindo-din dee-dindy-dinday
[ ——
: N - . - r\_I
O — 0 g g v O | - 90— —0 @ o9

> > >
Dee - um da dy-dindodin dee dy dum Dee -a dy da-dindo-din dee-dindy-dinday Dee-

: N = =
e e

. g . g

Dee - um di-di-ly ey-dindo-din dee-dindi-di-lydum Dee - a-dindi-di-ly a-dindo-din di-di-ly ey-dinday Dee-

_



Learning Irish Dance through Lilting

‘ Oide

The Ashplant Reel The Ashplant Reel
A o)
A /— ] > I I y ] —H— — r 3 — ! r 3 |
Or—WT—FT—F—FFF—F—F~F+FF—T -+ ptg—+—F iy ——te———F T —
0y, 4 o o & o 5 * 4 o o 3 ¢ ¢ ¥ 4 4494 IS d dedd 0T e S
dum da dy do dee dy dum da dy da do dee dy day Dee - um da dydindo-din dee dy dum da dy da-dindo-din dee-din dy-dinday
5 5
9 ! ! ! ] #ﬁ t I t Y 2 I t T T T | I T T T | T (7] N I
"\\_vm I I I I ! I I I 2 ! I I I ! I I I 2 ! . I T p—] T t r S - I I S I I E— — — — 7 N
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dum da dy do dee dy dum dy do dee da dy day dum da dy-din do-din dee dy dum dy do-dindee-din da-din dy-dinday Dee-
9 9
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13 14
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I I I Il | fl I A I 1 |
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dy ly do dee dee dy do dum dee dy day dy dee dum dee dy do - din dum dee dy - dil day dee - ey -din dee-din dum Dee-




Supporting Inclusion

The Ashplant Reel The Ashplant Reel

L) [——— 9 — T T s ]
lI ; T — — T 1 | +
e e s s e e s s B o s s s B st e = - = %
. = —— + e
Dee - um da dy-dindodin dee dy dum Dee-a dy dadindo-din deedindy-dinday Dee- Dee - um didily ey-dindo-din dee-dindi-di-lydum Dee - a-dindi-di-ly a-dindo-din di-di-ly ey-dinday Dee-
5
5 N
f " — — ————————— ! —p—r— K —— s — ——
# 1 T T—— ] " ¥ 1 1} I T I T <7 ] I ! y S >
£ I I I I I | | I I I .y I I. 1N d —T
R A 1 . —
um da dy-din do-din dee dy dum dy da do-dindee-din da-din dy-dinday Dee- -um di-di-ly ey-din do-din dee-din di-di-lydum dy - da dodindeedin didily ey-dinday Dee-
9
9 : — : . — s e e .
I —1 - [r— —1 0 I T ¥ 1
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I I I :l I 'V I = .I 1
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-um dy do dee dee dy do-dindum Dee dy-dinday dee - ey-din dee-dindum

—

 — |

dy ly do dee dee dy do-dindum dee dy-dilday dee - ey-dindeedindum Dee- dy ly-dindo-dindee-din di-dily ey-dindo-dindum shkid-er-y ey-dilday dee - ey-din di-di-lydum Dee-

]
I

| 1HER




Possible Lilting Syllables

. J 4 53

Dum Da Dydin Diddly
Dy Do Dodin Schkiddery
Dee Dy Day Deedin T_he next D i§ often drgpped €.g.
: diddly-um, diddly-ey, diddly-adin,
Dadin schkiddery-eydin
Lapadoo Dum Dee- Dee-um
Deedindoo Dy Dee- Dee-a
Dydindoo The next D is often dropped e.g. (U pbeat)

dee-um, dee-ey, dee-adindog

Yadindoo

Activate Your Voice Booklet, p.5



DLT Supporting Vocal Learning

* Google Chrome extension
- Change key and speed

* Loop sections of the music

DLT Supporting Vocal Learning

Transpose Extension for Google Chrome

Mote that this online tool will anly work in the Google Chrome browser

Hiseory Ly Transpose A ¥ i# Sattings
—
The Transpose extension ———T- R
enables the user to change the e -
key, pitch and tempa when o T + o
playing videos through the it e L o e B
Goagle Chrome browser (e.g, .
on Youtube). i arkar
toer corn y
R " g e
This extension also inciudes a M mse w O Actiete by
Iooping function
=
po— :
W B ey S,
To Install the Transpose Extension
« Open Google Chrome browser % Transpose A ¥ pitch » speed - loop
- Go to hitps /ichromewebstore googie. com/ o Shat . “ "
« Searchior Transpose’ Irish lilting brain massage W “The Ashplant” Reel
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Activate Your Voice Booklet, p.6


https://www.yout-ube.com/watch?v=RS4klFyB7RE
https://www.yout-ube.com/watch?v=RS4klFyB7RE

Learn Rhythm through Words

Preparatory Warmup

C
Up running up running up running up running

Up running up running running running up




Develop Step Movement

C
Up running up running up running up running
D so
Up running up running running running up

E la
Up running up running up running up running

Up running up running running running up

_



Consider the Learning
Musical Literacy
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Preparatory Warmup
Explore the Minor Pentatonic Scale
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Let's Sing



Supporting Singing in Harmony

Preparatory Warmup: 2-bar canons

1ﬁi,._,_i i!a‘! i" _& &
Comeon ba-by comeondar-ling Comeon ba-by comeondar-ling
2 0
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let me steal this momentfromyounow

What learning is at the heart of this exercise?

let me steal this momentfromyounow




Singing in Parallel 3rds
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Comeon ba-by comeondar-ling letme stealthis momentfromyounow
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Progressing
the
Learning

Building
the Score

bb.51-58




My Students, My Context ° ‘ Oide

T What learning in this
song might support
your students?

Activate Your Voice Booklet, p.14



Let’'s Sing! ‘ Oide
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Activate Your Voice Booklet, pp.11-14




Learning together, we...

 considered the Why, What and How of vocal warmups for classroom singing

shared our experiences of nurturing and motivating our young singers

discussed key considerations when selecting and preparing repertoire

demonstrated how DLT can support singing in the Music classroom

iInvestigated how to layer up the learning when teaching a song

experienced some beatboxing and lilting

explored singing as a learning tool when teaching other areas of the curriculum

meet the final series of our trilogy - Meet the Voice

_



Q&A




Best of Luck to All Our Young Musicians!

Coimisilin na Scriduithe Stait

State Examinations Commission

2026 JC Practicals

Mon 02 to Fri

2026 LC Pract
Mon 13 to Fri

2027 LC Pract

3 Mar

Mon 5 to Fri 16 April

ROVISIONAL

Monday, 2 November

LEAVING CERTIFICATE EXAMINATION

LEAVING CERTIFICATE VOCATIONAL PROGRAMME
PROVISIONAL* SCHEDULE OF EXAMINATION AND

COMPLETION DATES 2026/2027

NOVEMBER / DECEMBER 2026

Home Economics Food Studies
Coursework

Friday, 27 November

Latin Research Study Report

Ancient Greek Research Study
Report

JANUARY / FEBRUARY 2027

Friday, 15 January

Design & Communication Graphics
Practical Coursework

Classical Studies Research Study
Report

Friday, 11 December

Physics in Practice Investigation

Monday, 25 January
~ Friday, 29 January

Coursework Submission Window 1

Friday, 18 December

Friday, 5 March

Physical Education Physical
Activity Report

Economics Research Study

MARCH / APRIL 2027

Engineering Project Component

Friday, 12 March

Business Alive Investigative Study

Climate Action and Sustainable
Development Action Project

Friday, 26 February

Friday, 16 April

LCVP: Link Modules Portfolio of
Coursework

Biology in Practice Investigation
APRIL 2027

Textile Studies Elective Coursework i
Home Economics. Scientific and Social

Art Practical Coursework

Tuesday, 16 March

Computer Science Coursework
Project

Friday, 23 April

Drama Film and Theatre Studies
Creativity in Practice Project

Chemistry in Practice Investigation

Friday, 19 March

Physical Education —
Performance Assessment

Technology Practical Coursework

Tuesday, 20 April —
Thursday, 22 April

Art Practical Examinations

Saturday, 20 March —
Thursday 25 March

Leaving Certificate Oral
Examinations:

Irish, French, German, Spanish,
Italian, Russian, Japanese,
Mandarin Chinese, Lithuanian,
Portuguese, Polish and Arabic

Tuesday, 27 April -
Thursday, 29 April

Construction Practical Examinations

Wednesday, 28
pril

LCVP: Link Modules Written
Examination (10.00 - 12.30)

Friday, 9 April

Applied Mathematics
Mathematical Modelling Project

Monday, 5 April =

"9

Coursework Submission
Window 2

Monday, 5 April —
Friday, 16 April

Tuesday, 4 May —
Friday, 14 May

Music Practical Examinations

MAY 2027

Coursework Submission
Window 3

Tuesday, 4 May —
Thursday, 6 May

Engineering Studies Practical

Wednesday, 19 May

Leaving Certificate Computer
Science - Written Examination
Higher and Ordinary Level.
Section A & B: 9.30-11.00
Section C: 11.30 - 12.30

Friday, 30 April

Tuesday, 8 June —
Wednesday, 23
June

Agricultural Science Individual
Investigative Study

Politics & Society Citizenship Project
Geographical Investigation Report
History Research Study Report
Religious Education Practical
Coursework

Construction Studies Project
Component

Music, Higher Level Elective in
Composing

JUNE 2027

Marking (in schools) of Leaving
Certificat

Construction Studies Practical and
Project Components

Engineering Practical and Project
Components

Textile Studies, Elective Coursework in
Leaving Certificate Home Economics
Scientific and Social

Technology Practical Coursework
Art Coursework and Practical
Components

* Dates are subject to change in line with the
Standardisation of the School Year circular

Coursework Completion dates
Coursework Submission window

Examination dates

https://www.examinations.ie/misc-doc/EN-SC-54934724 .pdf



Digital Technology v Droichead Induction v Primary v Post-Primary v Oideachas tri mhean na Gaeilge v Leadership v

“Music is an art form deeply rooted in human nature. It contributes to the
development of artistic awareness and understanding, self-expression, self-

esteem, imagination and multicultural sensitivity, and therefore, to the
development of the whole person.”

www.oide.ie

Music Music

Music Junior Cycle Music Senior Cycle

Discover More Discover More



We welcome your
feedback

Failtitear roimh bhur
gcuid aiseolais




Oide

Tacu leis an bhFoghlaim Supporting the Professional
Ghairmitil i measc Ceannairi  Learning of School Leaders
Scoile agus Mdinteoiri and Teachers

Thank you for your
engagement!
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